Copyright

The information in this document is subject to change without notice. T-Metrics, Inc. assumes no responsibility for any errors or omissions that may appear in this document.

TM-2000 and PhoneGroups are trademarks of T-Metrics, Inc.

Meridian is a trademark of Nortel.

Microsoft, Microsoft Word, Microsoft Access and Microsoft Windows are trademarks of Microsoft Corporation.

HASP is a registered trademark of SafeNet, Inc.

All materials are Copyright © 2008-2012 T-Metrics, Inc.

If you have any questions or comments, please contact:

T-Metrics, Inc.
Customer Service
4430 Stuart Andrew Boulevard
Charlotte, North Carolina 28217 USA
Phone: +(1) 704.525.5551
Fax: +(1) 704.525.4886
EMail: sales@tmetrics.com

Or visit our Web site at:

www.tmetrics.com
# Table of Contents

INTRODUCTION .................................................................................................................. 4

ABOUT THE AGENT MODULE ......................................................................................... 5
  Color Coding .................................................................................................................. 6

STATUS WINDOW ............................................................................................................... 7
  Status Changes ............................................................................................................... 9
  Caller ID Window ......................................................................................................... 10
  Skillsets Window ......................................................................................................... 10

EXPANDED VIEW SCREEN ............................................................................................... 11

AGENT CALLBACKS WINDOW ........................................................................................... 12

ACD AGENT MODULE MENU BAR ITEMS ........................................................................ 13

FILE .................................................................................................................................. 13

EDIT .................................................................................................................................. 14
  Settings Menu .............................................................................................................. 14

INFORMATION .................................................................................................................. 21
  Informer <F11> ............................................................................................................ 21
  Help .............................................................................................................................. 22

MESSAGING ...................................................................................................................... 24

EMERGENCY BUTTON ....................................................................................................... 25

T-METRICS CUSTOMIZABLE SCREEN POP INTERFACES ............................................... 25

AGENT MINITAP ............................................................................................................. 26

OPTIONAL FEATURES .................................................................................................... 26
  Messages ...................................................................................................................... 26
  Completing the Customer Message Information ......................................................... 27
  Closing the Customer Message Window Without Call Resolution Selected ............... 28
  Agent Messaging ......................................................................................................... 28
  Chat Function .............................................................................................................. 29
  T-Metrics EMailer ........................................................................................................ 32
Introduction

The TM-2000 ACD / Call Center is designed to be the primary point of contact an organization has with its callers, providing a quick and efficient method to obtain the person in the organization who is most qualified to handle callers’ needs. Its integral parts consist of:

- Agents (representatives who answer the calls)
- Supervisors (people who view Agent and Queue statistics)
- Administrators (people who control call flow and manage the call center)
- Hardware and software to distribute calls to the appropriate Agents

The Agents use a PC to make themselves “Available” to take calls, make inquiries, and look up information for the caller.

The selection of an Agent to receive a call is based on:

- Agent availability (Status set to “Available”)
- Phone state (phone is on hook)
- The Agent’s skill set (ability) and preference level
- The amount of time the Agent’s phone has been idle (on hook)

When Agents become available to take calls (by logging in and selecting “Available”), they are marked as an “Available” Agent for each of their skillset assignments.

The goal of the TM-2000 ACD solution is to immediately connect each caller to the most appropriate resource or provide an interactive queue for callers when those resources are busy. They may also exit the queue and, upon returning to a menu, select among various options such as:

- Listen to an announcement
- Transfer to an extension
- Leave a message with callback information and hang up

In order for the TM-2000 IP ACD to effectively route calls and provide the fastest response to the callers, it is critical that the Agent positions are available to receive the calls.

The TM-2000 IP ACD Call Completion Call Center is made up of a number of IP-based modules that have very specific tasks. This manual discusses the use of one of these modules, the ACD Agent Module, which is used by the Agent to log on and off the ACD System.
About the Agent Module

The ACD Agent Module will configure itself in Agent mode, based on the user’s logon name. When the Agent Module logs onto the ACD Controller Module, the logon name is tested to see the job classification of the person logging on. If the person who logs on is only an Agent (as opposed to a Supervisor or an Administrator), then certain functions will be turned off or made inaccessible.

Shown below is the Main Screen of the ACD Agent Module:

![ACD Agent Module Main Screen](image)

**Figure 1. ACD Agent Module Main Screen**
Color Coding

There are several color coded signals that can be used to easily ascertain information on the T-Metrics ACD Agent Module. For example when an agent’s line is being used (whether the phone is ringing, a caller is on the line, or a caller is on hold) the Status indicator will change from a green Available to a blue Available.

![Figure 2. ACD Agent Module showing Color Coding](image-url)

Another indicator that will change colors, depending on the information it is displaying, is the number of agents available for each skill (discussed later in the Skillsets section). In the screenshots above, notice that the number of agents available in the “Holiday Support” skillset is “7”, while the numbers displaying how many agents are available in the “Demonstration2” and “TM_IVR” skillsets are “1” and “0” respectively. When the agent detects that there is only 1 agent available in a skill it will display the number 1 with two asterisks to the right and it will display in the color Gold. When there are no agents available in a skill, the agent will display a “0” with two asterisks and it will display in Red. More information about these features is available in the Status Window and Skillsets Window sections.
Status Window

Shown below is the Agent Module in the **Connected to Server** State. This is the State that automatically displays when the Agent Module is opened if the software successfully connects to the server. The user will not receive calls until they Log On and become **Available**.

![Status Window – Connected to Server](image)

**Figure 3. Status Window – Connected to Server**

To Log On, simply press the **Log On** button if your logon name was entered automatically by the system (see above). If your name was not already entered, enter your logon name and then press the **Log On** button.
The Agent Module automatically detects that the user is an Agent and places them in the “Available” Status, making them ready to receive ACD calls. The figure below shows an Agent in the “Available” Status.

Figure 4. Agent in the Available Status
Status Changes

The Status drop-down menu allows the selection of the Status item. With the exception of the required “Logged Off” and “Available” Status items, the rest of the settings are chosen by the Administrator(s) and stored in the ACD Controller database. Typical additional settings are “Performing Post Duties” and “Out to Lunch”. These settings will make the Agent “unavailable” to take calls. An Agent can only receive an ACD call if he/she is in the “Available” Status and the phone is on-hook (idle). Note: If an “Available” agent takes a call (off-hook state), the Status will change to a blue “Available” (see above section labeled “Color Coding”).

To change the Status, place the mouse over the drop-down menu in the Status Window and click to show all existing Status options. Move the mouse pointer over the appropriate Status and click. The selected Status will then be the only one showing. Click on the Change button to complete the process.

![Status Window](image)

**Figure 5. Agent Changing Status from Available to Performing Post Duties**

If an Agent is not going to be available to take ACD calls, then it is important for the agent to change their Status to make themselves “unavailable” (e.g., Out to Lunch, On Break, Performing Post Duties) so that calls will not ring at that position. Once the agent is ready to take ACD calls again, simply change the Status back to Available. Note that when an agent is in an “unavailable” state, the Status indicator color changes from green (Status = Available) to yellow (e.g. Status = Performing Post Duties).
**Caller ID Window**

This Window shows three pieces of data every time the agent has a call routed to them from the ACD. These data are **Caller ID, Hold Time, and Skillset**.

- **Caller ID** is the number that the caller is calling from. This may include the trunk number that the 10-Digit Number is a part of.
- **Hold Time** is the length of time for which the call has been in the system waiting for an answer from an agent.
- **Skillset** displays the Skill from which the caller needs assistance and thereby caused the ACD to route the caller to the agent. For instance, if an agent is a member of both Engineering and Support Skillsets, this indicator will display which of these two skills for which the caller is calling.

![Figure 6. Caller ID Window](image)

**Skillsets Window**

This Skillsets Window provides an easy way to view statistics about all the Skillsets to which the user is connected. The **Available** column provides the user with how many agents are in the “Available” state for each Skillset listed. The **Queue** column shows how many callers are in the queue for each Skillset waiting for an available agent. The **Msgs** (Messages) column shows how many (voice) messages each Skillset has.

At the top of the window is a display of the total of calls that are in Queue in the ACD and how many total Customer Messages there are.

![Figure 7. Skillsets Window](image)
Expanded View Screen

Open the Expanded View screen by pressing this button:

![Expanded View Button](image)

Figure 8. Expanded View

Columns in the **Skills Grid:**

- **Skill** – The name of the skill.
- **Avail** – The number of agents with a skill level higher than ‘0’ who are in the available position status.
- **Level** – The viewing agent’s skill level in the skill.
- **In Q (In Queue)** – The number of callers in queue for that skill.
- **Oldest** - The length of time that the oldest call in queue has been waiting for that skill.
- **Wait Avg** - The average length of time that a caller waited in queue before being answered by an agent. The time window used is based on just the last four calls that were in queue. The reason for the deviation for this statistic is to give relevant information for real-time use. (This number can be more volatile to give a better picture of how long people are waiting right now)
- **Msgs** – The number of voice messages (customer callbacks) waiting for processing in the queue.
- **Total** – The total number of calls that have been assigned to the skill. The time window for this statistic is reset daily at midnight.
- **Ansd** – The number of calls within ‘Total Calls’ that were answered by an agent – same time window as Total Calls.
- **Aban (Abandons)** – The number of calls within ‘Total Calls’ that were not answered by an agent – same time window as Total Calls.
- **Aban Avg (Abandoned Average)** – The average length of time that a caller waits for this skill before abandoning. The time window used is based on just the...
last four abandoning callers. The reason for the deviation for this statistic is to give relevant information for real-time use. (This number can be more volatile to give a better picture of how long people are waiting before hanging up right now)

- **Aban % (Abandoned Percentage)** - The percentage of abandoned calls vs. Total Calls - same time window as Total Calls.

- **ASA (Average Speed of Answer)** - The average length of time that a caller waits once assigned to a skill before being answered by an agent. This, along with SLA, is based on a special window of time that is adjustable per skillset to allow for different standards for different skills.

- **SLA (Service Level Agreement)** - The percentage of calls that were answered within the period of time as defined in the Controller module for that skill. This, along with ASA, is based on a special window of time that is adjustable per skillset to allow for different standards for different skills.

- **Group** – The name of the group of which the skill is a part. If the skill is not part of a skill group then this column is blank.

- **Off (Skill is Off)** – This checkbox is checked if the skill is turned off for the Agent. Administrators are able to assign the ability so that an Agent can turn off/on skills at will. This ability can be limited by the Administrators on a per skill basis.

### Agent Callbacks Window

The Agent Callbacks window, accessed by choosing the “Edit” menu and then clicking “Agent Callbacks”, is used when an Agent is working with a caller who will need to call back regarding the same problem. By using this feature, the Agent will be able to give the caller specific callback instructions, which will allow the caller to be connected to the same Agent that has helped before. You must be active, on an ACD call, to use this feature.

![Agent Callbacks Window](image-url)
The Agent is able to enter a brief message about the call in the window pane on the right, such as “John Doe is calling back with the account information for his checking account”; choose the amount of time the callback will be valid from the Callback Account is Valid For list, such as “The remainder of today”; and then click on the Request Callback Account Number button. A Callback PIN will appear for the Agent to give to the caller, along with instructions as to what telephone number to call back.

When the caller returns the phone call to the Agent this screen will reappear and the brief message entered by the Agent will appear in the white display list box in the right window pane where it was entered.

**ACD Agent Module Menu Bar Items**

Listed below are the items on the ACD Agent Module menu bar.

**File**

**Server Messages**
This displays all messages between the server and the Agent client.

**Show Activity Items**
This option allows the agent to view all the activity items that are tied to each of the skills with which the agent is associated.

![Figure 10. File Menu](image)

**Show Expanded View**
This opens the expanded view of the Agent Module.

**Show Past Caller IDs**
This option is used to view caller ID stamps from earlier in the day, as opposed to the one currently showing in the Caller ID window.

**Show Previous CallBack Messages**
This function displays a window with a list of Customer Callbacks previously delivered to this agent position. The window will display the File Name, Caller ID, and Call Time of each...
Customer Callback. From this screen, a file can be selected and, by pressing the Get File button, downloaded to the local computer.

**Exit**
This is used to close the ACD Agent Module and log the Agent off the ACD system.

**Edit**

**Agent Callbacks**
This brings up the Agent Callbacks window explained above.

**Settings Menu**
Accessed by means of the Edit > Settings, this window allows you to change several settings concerning the ACD Agent Module. The first option in the settings window is the Connections and Miscellaneous Settings menu.

Figure 11a. Access Edit Window

Figure 11b. Edit Window

- Connections and Misc Settings Screen
  - **ProgramName** – The program name of this module (This should always read ACDAgent)
The server where events are being sent to.
- **DeskPhone**: The desk phone number where calls for this Agent Module will be routed. This phone number needs to be the exact number the incoming trunk must dial to reach this desk phone. Also, this number must exactly match the phone number of the MDN being monitored in a Hardware Interface Module.
- **BlkXtraMsgs**: Blocks extra messages from displaying on the Agent tab list box.
- **Order**: The order in which this module tries to connect to the server.
- **ExcludeEntry**: If checked, excludes using this entry when searching for a server.
- **RetryInterval**: If connection to the server fails, this shows the length of time to try and connect again.
- **LocalPort**: The port through which the server communicates with the client.
- **PopWithCall**: This option allows the ACD Agent Module to come into focus when a call is received.
- **RecordAllCalls**: This option causes all calls to be recorded to a specific directory (Default: C:\Tmetrics\TMIA CDAG e ntMod u le\CallRecordings).
- **CannotRedirect**: This option, when checked, does not allow the T-Metrics ACD to pull a call back into the system after the RedirectUnansweredCalls timer expires. This feature is used in conjunction with Remote Agents.

Next in the settings window are the **Bubble Forms and System Tray Icon** options:

![Bubble Forms and System Tray Icon](image)

- **Bubble Forms** pop up when certain events occur, such as an incoming call or an instant message. From here, the administrator may enable/disable the Bubble.
Form feature, as well as configure the Bubble Forms’ fade settings. Additionally, the administrator may set the Agent Module to minimize to the System Tray from this menu.

- **Agent Tagging** allows a supervisor or administrator to receive alerts when specified agents take specified actions, like changing position or phone states.

Next in the settings window is the **Data Grid Options** screen:

![Data Grid Options](image)

**Figure 13. Data Grid Options**

- The **Data Grid Options** menu allows the administrator to customize how information is displayed within the Agent Module. From here, changes may be made to the grid display, concerning grid location, ordering, font, symbols, etc. From this menu, the Administrator may also create a **Customized Agent Grid Filter**, displaying only specified agents.

Next in the settings window is the **E-Mail and Trouble Report Settings** panel:
This menu allows the user to quickly and easily report problems to the T-Metrics support team. From here, the user would fill in their name, as well as their E-Mail Address or phone number – preferably both, though only one is required. The user then selects which email client their PC uses, and an email addressed to the T-Metrics support team will automatically open when sending a trouble report. To send a trouble report, select “Send Trouble Report” from the Help menu.

Next in the settings window is the Greeting Files Option:
Figure 15. Greeting Files Form

- From this menu, a user may set which greeting file they wish to play at their station for selected skills.
  - Filename – The filename of the audio file to be used as a greeting
  - Skill – The skill that is to be used with the greeting file
  - Phonenumber – The phone number of the user
  - UserName – The agent’s username

Next in the settings windows is **Instant Messages** panel:

![Instant Messages settings](image)

**Figure 16. Instant Messages**

- From this menu, the user can configure the instant messenger and chat features included in the ACD Agent Module.
  - Pop Incoming IM’s to the Front -- This option allows incoming Instant Messages to display in the forefront of the user’s screen. It will load on top of any other window that is open.
  - Play Sound for Incoming IM’s -- This option allows an audible sound to play when an instant message is received through the ACD Agent Module.
  - Show Status Changes of Other Agents in Instant Message Windows – This option will display the current status of the agent the user is messaging in the chat window.
  - I Have a Chat Server – its Network Address (or Computer Name) is: -- If a Chat Server is available, it will need to be set via this option. After the Network Address or Computer Name is set, the user will need to restart the Agent Module before they can join or create a chat room.

Next in the submenu is **Sound Devices**:
This menu allows the user to choose which sound device will be used in conjunction with the ACD Agent Module software.

- **Play Device** – The audio device used for audio playback for the agent
- **Recording Device** – The audio device used to capture call recordings
- **Listen Device** – The audio device used by a supervisor when listening to an agent’s live call

Next in the submenus is **User Interaction:**
Figure 18. User Interaction

- This menu allows the user to make several selections to customize how they will interact with the Agent Module.
  - Allow Use of Keyboard (Enter Key) to Select Activity Items
  - Allow Use of Keyboard (Enter Key) to Change Position Status
  - Show My Current Status Time Next to My Position Status
  - Minimize the Agent Module to the System Tray
  - Confirm with User Prior to Sending Emergency Messages
  - Disable the Emergency Button
  - Show Status Details Input Box

- The user may also assign Global Hotkeys to perform common actions via keyboard shortcut.

**Toggle Skills**

If an Agent has been given the ability to turn on and off Skills by a Supervisor, this feature will allow the Agent to perform those actions.
Information

**Informer <F11>**
This is used to pop up the Information Directory, shown below, which is used to access information using a Windows Explorer-type of form. This data can be anything, including documents in text and RTF and pictures in such formats as BMP, JPG. Also URL address on the web can be accessed through the viewer.

![Information Directory Showing an Area Code Table](image)

*Figure 19. Information Directory Showing an Area Code Table*
Help

The Help menu item has five options under it, which are Check for Updates, Send Trouble Report, Agent Module Quick Reference Guide, Agent Module User Guide, Remote Connection, Remote Connection – Custom, and About Agent Module.

Figure 20. Help Menu

Check for Updates
Clicking on this item will cause the PC to look across the network to the T-Metrics Support site to see if there is a software update available.

About Agent Module
About Agent Module is an about box telling who made the product and the version of it.

Figure 21. Agent Module Information Box Showing Version Number
**Send Trouble Report**

In the event that a problem occurs, **Send Trouble Report** is used by an Agent / Supervisor to trap the most recent activity on the Agent / Supervisor PC and on the ACD Server that will be forwarded to the T-Metrics Support Staff.

To make a file that will be sent to T-Metrics, do the following:

- Click on the **Help** menu at the top of the screen and select the **Send Trouble Report** option. The screen below will appear.

![Figure 22. Trouble Report Form](image)

- Follow the on screen instructions and submit the Trouble Report by clicking **Send Email to T-Metrics Support**, **I Will Call T-Metrics**, or **I Will NOT Contact T-Metrics Support**.
Remote Connection and Remote Connection Custom

T-Metrics may request that you use this feature to allow us to remotely control your PC in order to fix an issue. T-Metrics will provide instructions on how to use this feature should the need arise.

Messaging

The **Messaging** button is used by an Agent to request help from a Supervisor. Pressing this button brings up a form that allows the Agent to enter a text message that is then sent to the Supervisor. The Supervisor can respond and send a text message back to the Agent. They can continue sending text messages back and forth until the problem has been resolved. This is very handy when an Agent is working with a caller and wants to ask the Supervisor advice on an issue. The Supervisor is able to help the Agent without going to the Agent’s position or without the caller realizing the Agent is getting help from the Supervisor.

A message box appears when the Agent clicks on the **Messaging** button. The Agent then fills out the text area and clicks on the **Send** button to send the message to the Supervisor.

![Figure 23. Agent Message Screen Pop](image)

![Figure 24. Supervisor Message Response Screen Pop](image)

The Supervisor receives the message and can write a response back to the Agent.
Emergency Button

Clicking on the Emergency button sends an immediate message to a Supervisor, making him/her aware that a particular Agent is having an emergency condition.

Figure 25. Emergency Request Screen Pop

T-Metrics Customizable Screen Pop Interfaces

T-Metrics has developed Screen Pop Interfaces for several of our customers. In each instance we have worked with the in-house expert from the customer site to develop tools that assist operators in using T-Metrics software in conjunction with their already existing systems.

T-Metrics has been able to successfully integrate several clients like CHCS, Remedy Interface, Magic Interface, and Web Client Interface.

Working with a customer to create a useful apparatus, T-Metrics has the ability to create software which will work with an existing system. For example, by merging our ACD and a customer service system owned by a customer, it is possible for a customer to enter a customer ticket number while they wait in queue and have the system “pop” a screen to the operator at the appropriate time bringing up their ticket containing all their information.
Agent MiniTAP

The Agent MiniTAP will allow for agent greetings and recording of telephone calls. It is also required at each Agent position for the Supervisory Listen & View feature, in addition to the HASP key at the Supervisor position.

Figure 26. Picture of the T-Metrics Agent MiniTAP

Optional Features

The T-Metrics Agent module includes several optional features, which may be activated depending on the site’s needs, hardware setup, and purchased services.

Messages

Retrieve a Customer Message
This option is in place to allow an agent to retrieve Customer Messages (voice messages) left by a caller for a skill manually when the system is configured to withhold them until they are requested by an agent.

Conversely, the system can be configured so that callers can leave a Customer Message that will either be delivered to an “Available” Agent when there are no “live” calls to be presented, or delivered to an agent as if it were a live call with its own place in queue (depending on the way the system is configured). When a Customer Message is sent to an Agent, the Agent is presented with the Customer Message Information window shown below.
In order to listen to the Customer Message, the Agent will click on the **Listen To Msg** button. The Agent’s desk phone (either a standard phone or a T-Metrics SoftPhone box) will then ring and the Agent will be instructed to “Press any key to play the message”.

- For Agents using a standard phone set, press any key on the telephone keypad.
- For Agents using a T-Metrics Console, go to **Telephone Tools** on the menu bar, select **DTMF Send <CTRL+Alt>**, and then press any digit on the keyboard.

The Agent can press any key to play the message again.

**Completing the Customer Message Information**

When the message has finished playing, the Agent must select one of the other buttons on the **Customer Message Information** window to indicate the action taken in regards to the message:

- If the Agent reaches the caller and completes the message, the Agent presses the **Customer Called** button and the window will close. This will mark the call as “Cust Called” in the call records log for reporting purposes.
If the Agent is unable to complete the message (e.g., leaves a message for the caller, etc.), the Agent presses the Customer Unavailable button and the window will close. This will mark the message as “Cust Unavailable” in the call records log for reporting purposes.

Closing the Customer Message Window without Call Resolution Selected

- If the Agent closes the Customer Message Information window by selecting the \( \times \) in the upper right-hand corner, the message will be sent back to the Agent to retrieve again. If the Agent receives an incoming call, the message will be sent to the Agent when the position is “Available”. If the Agent makes his/her position unavailable (by selecting “On Break”, “Out to Lunch”, etc), the message will be routed to the next available Agent.

- If the Agent closes the Customer Message Information window by pressing the Close with No Action button, the message will be sent back to the Agent to retrieve again. If the Agent receives an incoming call, the message will be sent to the Agent when the position is “Available”. If the Agent makes his/her position unavailable (by selecting “On Break”, “Out to Lunch”, etc), the message will be routed to the next available Agent.

**NOTE:** The Customer Message Information window should not be closed by these methods as it creates reporting errors in the call reconciliation process.

Agent Messaging

In addition to sending IM messages to Supervisors, Agents may send IMs to one another, if the Administrator has enabled “IM for All” for their skillset on the server.
When “IM for All” is enabled, the Agent will see two bullet options: **Agent(s)** and **Skillset**. Under **Agent(s)**, the Agent may select one or several specified agents to whom they may send an IM message. Under **Skillset**, the Agent may choose to send an IM to ALL agents and supervisors with a selected skill.

### Chat Function

The T-Metrics system also provides the option to use Chat Rooms. Unlike the IM feature, the Chat Rooms offer agents and supervisor to have a group discussion. If the site is using a chat server, and that server has been set in the ACD Agent Module’s Instant Messaging Settings windows (see pages 18-19), then the Agent will see additional options when clicking on the **Messaging** key.
Figure 29. Messaging Window with Chat Room selection

The Agent may select **Join a Room**, and then select from any of the available public or private rooms currently in operation.
If the Agent selects **Create a Room**, a set-up window will appear, prompting the Agent to provide a Chat Room Name, select whether the room will be moderated or unmoderated, whether the room will be public or private, which agents will be allowed to issue invitations to the chat. The set-up windows also provided the Agent with the option of setting an initial topic for the chat.
**T-Metrics Emailer**

The T-Metrics Emailer provides the Agent with a singular communications solution. With the T-Metrics Emailer working in conjunction with the TM-2000 IP Platform, and the client’s email server, Agents will receive all calls and emails by the same means. Rather than juggling their workload between the Agent Module and a separate email client, Agents will receive email messages from their Agent Module via pop-up window, when they are not taking calls or are otherwise Available.

![Emailer Window](image)

**Figure 32. Emailer Window**

The Emailer Window:
- **Email Information**: Provides basic information, such as the “To” and “From” address, carbon copy and blind carbon copy lists, email subject line and attachments.
- **Email**: The body of the delivered email.
- **Your Reply**: Where the Agent types their response.
- **Attachments**: Allows the Agent to add/remove files to their response as attachments.
- Place Back in Queue: Allows the Agent to place an email message back in queue. When selected, the Agent is given the option of redirecting the email to a specific user.

![Redirect Window](image)

**Figure 33. Redirect Window**

- If the Agent selects **Yes**, the Agent will choose from a list of logged-in agents, and be given an input form to note the reason why the email is being redirected.

![Redirect to Agent Window](image)

**Figure 34. Redirect to Agent Window**

- If the Agent selects **No**, the Agent will be given an input form to note the reason why the email is being redirected, after which the email will be placed back in
queue and delivered to the next Available agent.

![Redirect Reason](image)

**Figure 35a. Redirect Reason**

- The Agent who receives the redirected email, will also receive a pop-up with the message the previous agent noted in the input form.

![Redirect Notification](image)

**Figure 35b. Redirect Reason**

- Spam: Allows the Agent to flag the delivered email as spam.
- Ignore: If selected, the delivered email will be marked as handled, but a reply is not sent.
- Address Book: Opens your email program’s address book. (Microsoft Outlook will need to be open and have focus to pop the address book.)
- Direct Replies Back to Me: When checked, replies to this email chain will be automatically redirected to the agent who handled the message, and not placed in the general queue.
- Send Reply: Sends the Agent’s response.